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Starting Composer
To start Netscape Composer, click on the Start button on the taskbar,
select Programs  from the list,
select Netscape Communicator,
select Netscape Composer.

Alternatively, if you already have a Netscape window open (either Navigator or
Messenger), select Communicator from the toolbar and then Composer from the
dropdown menu. Communicator can also be started by clicking on the pen and paper icon
at the bottom of other Netscape windows.

This will open Composer with a blank untitled web page opened for editing. To open a new
blank web page at any time, from the File menu, select New and then Blank Page or click
on the New icon. To open an existing page for editing, either click on the Open icon or,
from the File menu, select Open Page and then Choose File and browse for the file to
edit.

Editing Pages in Composer

The Editing Toolbar
Most editing functions in Composer can be carried out from the format toolbar, which
generally appears as the last toolbar at the top of the page. The fields in the toolbar have the
following purpose:

Paragraph style: Allows text to be formatted to pre-defined heading styles.
Applies to selected paragraph.
Font: Apply font to selected text - do not use.
Font size : Specify relative size of selected text - do not use.
Font colour: Specify font colour of selected text - do not use.
Bold: Set selected text in bold type.
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Italic: Set selected text in italics.
Underline : Set selected text with underlines. Not recommended because looks like
link text.
Remove all styles: Remove all explicit text formatting.
Bullet list: Set selected paragraphs as bullet points.
Number list: Set selected paragraphs as a numbered list.
Indent/Outdent: Indent or outdent selected paragraph.
Alignment: Left, centre or right justify selected paragraph.

Formatting Text
Use the format field in the toolbar to format text within the webpage. The formatting style is
applied to the selected paragraph of text. For body text, this field will be set to either
Normal.

In order to specify text as a heading, click anywhere in the line of heading text and select
one of the heading styles Heading1 to Heading 6 from the drop down list. This will format
the text as the appropriate level of heading. To check the way that the heading will appear in
the live page, you can go to the webguide <http://www.adelaide.edu.au/webguide>.

Do not use Font, Font size or Font colour to format text as these types of formatting are not
compatible with the style sheets used with the University templates. If they are used, they
will be stripped from the text when the page is displayed and so the page will not have its
intended appearance. In addition, they may cause the style sheets to "break", stopping any
correctly applied heading styles from being applied.

Bold and italics formatting can be applied to selected text for minor headings and highlighting
within a paragraph. Note that underlining text for emphasis is not recommended as it may be
confused with a link.

Creating and Editing Links
To create a link, select the text to appear as the hyperlink and then click the Insert Link
icon. A pop-up box will be displayed allowing you to enter the URL of the link in the entry
field. There are several ways of doing this. If the link is a link outside the site, type the
hyperlink into the link field (you can use cut and paste from your browser). If the link is
within your site, click on Choose File to use the windows browse to select the link you
require. This will create a relative link, showing the link relative to the current page, which is
the recommended way of entering links to pages within your site.

To change a link, click anywhere within the link text and use the same techniques to change
the link details within the link field.

To delete a link, click anywhere within the link, click the Link icon and then click on
Remove Link.
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To create email links, follow the steps outlined above and in the link field enter
mailto:email_address where email_address is the email address to mail to when this link is
clicked.

Creating Targets
Targets, or anchors as they are also known, are used to jump to a specified point within a
webpage.

To create a target, place the cursor at the point you want to jump to in the page and click
the Target icon. Enter a name for the target and press enter. It is good practice to give the
target a name that relates to its position within the page, for example, if it is at a heading a
short form of that heading would be a suitable name. A target icon will appear in your
webpage to denote the target point. Note that this is not visible when the page is viewed
through a browser.

You can then create a link to this target within the page by typing #target_name  within the
link field when creating a link as described above. You can also link to a target in another
html page by typing web_page#target_name  for a target set within that page.

Inserting Images
To insert an image into your web page, first place your web ready image file within your
local web site on your hard drive, preferably in a folder created specifically for storing
images. To insert the image click on the Image icon in the objects toolbar or go to the
Insert menu and select Image. Enter the image file name in the pop-up window which is
displayed. Remember to upload the image file to the server when you upload your webpage
or it will not be visible when the page is displayed.

To wrap text around the image select the Left or Right option for text wrapping,
depending on which side of the text you want the image to appear.

Avoid scaling images within your html pages by always using a program such as photoshop
to save the images to the required site and format before inserting them into your html page.

Tables

Insert a Table
To insert a table click on the Table icon in the objects toolbar or go to the Insert menu and
select Table. Select the appropriate options for the table in the pop-up window which is
displayed:
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Enter the number of rows and columns you require for the table. In general, a table Border
of 1 with a Cell Padding of 5 and a Cell Spacing of 0 will give an attractive, simple table.

Modify Tables
There are numerous options available for modifying a table within your webpage. To edit
basic table properties, click the cursor inside the table and click the Tables icon. For more
editing options, from the toolbar select Format and then Table Properties. Depending on
the tab selected, Table, Row or Cell, different aspects of the table or table element can be
changed.

Saving Webpages
When you have finished making changes to the webpage you can save changes by selecting
File and Save from the top menu bar or by closing the file and clicking Yes to save
changes. Alternately, when you close the file, Composer will prompt you whether to save
your changes. Click Yes to save.

Note that when you save a file the update information which is displayed at the bottom of
the page will automatically be updated with the current date so that others can see the page
has changed.

Site Management

Using WS_FTP
Start WS_FTP by clicking on the start button, selecting Programs , then Internet Tools
and finally WS_FTP.



DW_Training 7/24/02 5

The first time you use WS_FTP to connect to the development server you must enter
information to define the connection. Subsequently, make sure the profile name is the one
you specify for the connection to the development server and the remaining settings will be
remembered.

Setting up WS_FTP Access
To define the ftp connection to the webdev development server, start WS_FTP and enter
the following information:

Make sure that the General tab is selected and enter the following information:
• Profile name: any name that will remind you that this is the connection to your internet

site.
• Host Name/Address: webdev.adelaide.edu.au
• Host Type: Automatic detect
• User ID: Your email login- xxxxxnn where xxxxx is the first letter of your first name and

the first five letters of your surname and the nn is the unique number assigned to you
• Password: Your email password.

• If your computer is secure, tick the checkbox for Save pwd.
• Account: Leave blank
• Comment: Leave blank

Click on the Startup tab and enter information in the following fields.
• Initial Remote Site Folder: the location of your site on the server.
• Initial Local Folder: the folder on your hard drive where you will be saving files

temporarily in order to update them.

Downloading files to edit
Once you connect to webdev with WS_FTP you will see a window with two lists of  files.
The one on the left is the local system, that is, your hard disk, while the one on the right is
the remote site, which is the webdev server as shown below:
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In general, it is recommended that you set up WS_FTP so that the local system is set to
your top level web folder and the remote system is set to the top level of your web site on
the server. It is also strongly recommended that you mirror the structure of your web site
from the server to your local computer. That helps in ensuring that the intended files are
always uploaded and downloaded.

Navigate through both your local and remote sites to the file you want to edit. To do this,
double click on a folder below your current folder to move to it, or double click on the
"uparrow with dots" at the top of the list to move one level up the folder structure.

Once you have both the local and remote sites at the appropriate folder, click on the file you
want to download in the right hand (remote server) window. Then click on the left pointing
arrow (<=). This will copy the file from the server to your local computer, allowing you to
make changes to the webpage.

Uploading modified (and new) files
Once you have made changes to the file, or have created a new file, you must then upload
the file to the web server to enable people visiting your web site to see the webpage.

To do this, click on the refresh button to the right of the local computer window to make
sure that you are looking at the correct file to upload, by checking the date on the file. Once
again, make sure that the local and remote sites are set to the same folder, then click on the
file you want to upload in the left hand (local computer) list and click on the right pointing
arrow (=>) to upload it. Doing this will copy the file from your local computer to the web
server, making the page visible on the development web site where they can be previewed
to make sure they are working correctly before they are uploaded onto the live web server.
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Creating Pages from Templates
There are three standard templates available for creating new web pages. These are as
follows:
tmpl_1.html: single column format without any navigation, generally used for wide tables or
front pages.
tmpl_2.html: the most commonly used format with a left hand navigation area and a right
hand main page area.
tmpl_3.html: similar to tmpl_2.html but with an extra column for images or side bar
information.

To create a new page from the templates, connect to the server and change to the templates
directory on the server. Change to the local directory where you want to create the new
page. Copy the template to the local computer. Rename the template to the required
webpage name. You can then add content to this new page as required.

Further Information
The University of Adelaide web site has a sub site designed to provide information to people
creating and maintaining web sites within the University. This can be found at:
• The University of Adelaide Web Guide: http://www.adelaide.edu.au/webguide
• List of header styles: http://www.adelaide.edu.au/webguide/howto/style.html


